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Purpose of Guide
One of PracticeMaster's most powerful features is the ability to create customized reports based on
any information stored in PracticeMaster. The PracticeMaster Report Writer Guide covers creating
both basic and complex reports, a breakdown of each piece of the Report Writer, and scenarios to
get you started.
Additional guides for other software features are also available. All guides are available on our Web
site at:

Tabs3.com/support/docs.html

Knowledge Base
You may be referred to additional detailed information located in our Knowledge Base on the
Internet at:

support.Tabs3.com

Additional Resources
A comprehensive list of all resources for Tabs3 and PracticeMaster can be found on page 45.
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Report Creation Made Easy
The PracticeMaster Report Writer can create basic and complex reports. Let's look at a few basic
scenarios to get an idea of how you can easily create and edit reports.

Creating a Report
Let's say you want to create a basic report that shows the Client ID, Client Name, Date Open, and
Area of Practice. This can easily be completed using the Report Wizard.
▶ To create a report using the Report Wizard
1. From the PracticeMaster Task Folders, click the Reports tab, and then click the Report
Writer icon.
2. Click the

toolbar button.

3. Enter the desired Report Name that is 8 characters or less, such as BasicCL.
4. Click OK. The Main panel of the Report Wizard will be opened.
a. Enter a Title for the report, such as Basic Client List.
b. Click Next.
c. From the Fields panel of the Report Wizard, double-click each field you want
included on the report. Using our example, you would double-click Client_ID, Name,
Date_Open, and AOP.
d. Click Next.
e. Click Finish to save.
5. Preview the report as discussed in the following section.

Figure 1, Creating a Report
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Previewing a Report
Creating a report is a process that can take several rounds of editing. Once the base report is created,
preview the report in order to determine what changes need to be made. Do fields need to be
added? Do the columns need to be rearranged? Do you need to add a filter so as to limit the results?
Previewing the report is an important step in the report creation process.
When working with the Report Wizard, you can preview the report from the Report Writer window
by doing one of the following:
l

Double-click the report

l

Select the report and click the Print button

l

Right-click the report and select Print

When working with the Report Writer Editor, you can preview the report from the Report Writer
Editor window by clicking the

button.

Adding Fields to a Report
Let's say you now want to add the client's city and state to the report.
▶ To add fields to a Wizard report
1. From the PracticeMaster Task Folders, click the Reports tab, and then click the Report
Writer icon.
2. Select the report you want to modify.
3. Click the Modify button.
4. The Report Writer Wizard will be opened.
a. Click Next.
b. Double-click each field you want to be added to the report. Using our example, you
would double-click City and State.
c. Click Next.
d. Click Finish to save.
5. Preview the report to review changes.
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Figure 2, Adding Fields to a Report

Changing the Column Order
Let's say you want to change the order in which columns appear on the basic report we created.
▶ To change column order in a Wizard report
1. From the PracticeMaster Task Folders, click the Reports tab, and then click the Report
Writer icon.
2. Select the report you want to modify.
3. Click the Modify button.
4. The Report Writer Wizard will be opened.
a. Click Next.
b. In the Report Fields list on the right side of the window, select a field to be moved
and use the Move Up and Move Down buttons to place the fields in the desired
order. The order shown in the list reflects the order of the columns on the report.
c. Click Next.
d. Click Finish to save the report definition.
5. Preview the report to review changes.

Figure 3, Changing the Column Order
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Adding a Filter to a Report
Let's say we now only want to see clients who are part of the Workers' Compensation and Personal
Injury areas of practice in the basic report we created. You will launch the Report Writer Editor from
the wizard to add a filter.
▶ To use a filter in a Wizard report
1. From the PracticeMaster Task Folders, click the Reports tab, and then click the Report
Writer icon.
2. Select the report you want to modify.
3. Click the Modify button.
4. The Report Writer Wizard will be opened.
a. Click Next twice to display the Finish panel.
b. Click Next again.
c. From the Finish window, in the Report Writer Editor section, click the Editor button.
i. From the Filter tab, click the New Row button.
ii. In the list of fields, select AOP and click the Insert button.
iii. Make sure that the selected Test Condition is equal to.
iv. Click in the Test Value field and enter "WC".
v. Click the New Row button.
vi. In the list of fields, select AOP and click the Insert button.
vii. In the And/Or column, select Or.
viii. Make sure that the selected Test Condition is equal to.
ix. Click in the Test Value field and enter "PI".
d. Click

to save.

5. Preview the report to review changes.

Figure 4, Adding a Filter to a Report
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Changing the Default Sort
Let's say you now want to sort all records by their open date, starting with the newest client, in the
basic report we created.
▶ To change the default sort on a report
1. From the PracticeMaster Task Folders, click the Reports tab, and then click the Report
Writer icon.
2. Select the report you want to modify.
3. Click the Modify button.
4. The Report Writer Editor will be opened.
a. On the Image Layout tab, click the

toolbar button.

b. On the System tab, in the list of fields, select GLOBAL and click the Insert button.
c. In the Header Position field, select Before.
d. Click OK.
e. On the Image Layout tab, click the

toolbar button.

f. On the File tab, in the list of fields, select Date_Open and click the Insert button.
g. In the Sort Order field, select Descending.
h. Click OK.
i. Click

to save the report definition.

5. Preview the report to review changes.

Figure 5, Changing the Default Sort

Review
Using just a few scenarios, we have created a new report, added fields to it, changed the column
order, added a filter, and changed the default sort. Our new report provides the Client ID, Name,
Date Opened, City, State, and AOP of those clients who are part of the Workers' Compensation and
Personal Injury areas of practice in order of newest client first. This demonstrates how you can easily
create a basic yet powerful report using PracticeMaster Report Writer.
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Report Writer Window
Menu:

Reports | Report Writer

Task Folders:

Reports | Report Writer

Let's take a closer look at the Report Writer window. The Report Writer window is comprised of a
table of contents, buttons, toolbar, and the right-click menu.

Figure 6, Report Writer window

Report Writer Table of Contents
Reports are shown in a Table of Contents list which is in alphabetical order by Report Name. You can
change the sort order of records by clicking a column heading.

-7-

PracticeMaster Report Writer Guide

You can use the PgUp, PgDn, Up-Arrow, Down-Arrow, Home, and End keystrokes as well as the
scroll bar to scroll through the Table of Contents. The information to create each report is stored in a
file that is referred to as a report definition. Report definitions are created using the Report Wizard or
the Report Writer Editor. Report definition files end in *.RW. All PracticeMaster report definitions are
stored in the \CMREPORT folder under the current working directory. Listings of report definitions
can be printed.
Technical Note: The Table of Contents information is stored in a file named CMRW.TOC and is
located in the \CMREPORT folder.

Report Writer Editors
PracticeMaster offers two editors for creating report definitions: the Report Wizard and the Report
Writer Editor. Both types of reports are accessed from the Report Writer window.
Report Wizard

The Report Wizard can be used to quickly create basic
reports.

Report Writer Editor

The Report Writer Editor can be used for creating more
complex reports and can be used to access all details of
any report definition. The Report Writer Editor is also used
to modify Client Summary Reports.

Note: The Table of Contents in the Report Writer window includes an Editor column. This column
indicates whether a report definition was last accessed with the Report Writer Editor or the Report
Wizard. Reports last accessed using the Report Writer Editor will show “Editor” in this column.
Reports last accessed by the Report Wizard will show “Wizard” in this column.

Report Structure
Reports are classified as Simple Reports or Client AOP Reports.
Simple Report

A Simple Report, also called a Normal Report, uses a
single file or uses a file that links to a single record file. The
Timekeeper List is a classic example of a Simple Report.
These reports are shown in the Report Writer window by
right-clicking the Report Writer window, pointing to Filter
and selecting View Normal Reports.
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A Client AOP Report uses multiple files and essentially
consists of multiple Simple Reports "strung together" per
client. The Client Summary Report is a classic example of a
Client AOP Report. These reports are shown in the Report
Writer window by right-clicking the Report Writer window,
pointing to Filter and selecting View Client AOP Reports.

Client AOP Report

PracticeMaster provides you with a group of core reports which are referred to as system reports.
System reports are provided with the software. The report
definitions for the system reports begin with an
underscore character. If desired, these reports can be
modified via the Report Writer Editor. The Master Client
List is a classic example of a System Report. These reports
are shown in the Report Writer window by right-clicking
the Report Writer window, pointing to Filter and selecting
View System Reports.

System Reports

Report Name Window
The Report Name window is shown when creating, renaming, or copying a PracticeMaster report
definition via the Report Wizard or the Report Writer Editor.

Figure 7, Report Name window

Report Name

Maximum of 8 characters. The Report Name can consist
of letters, numbers, and the underscore character. The first
character of the Report Name must be a letter or a
number because the underscore character is reserved for
system reports. The Report Name is shown under the
Name column of the Table of Contents.
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Structure

The structure determines whether the report will be a
Simple Report or a Client AOP Report. This option is only
available when adding a new report. When creating a
Client Summary Report, the structure is automatically
configured as a Client AOP Report. When creating a report
using the Report Wizard, the structure is automatically
configured as a Simple Report.

The OK button can be used to create the report definition and close the window. When creating a
new report, either the Report Wizard or Report Writer Editor will be displayed.
The Cancel button can be used to close the window without creating a new report definition.

Report Writer Buttons
Report writer activities are accessed by selecting the desired report and then using the buttons at the
bottom of the window, the toolbar buttons, or the right-click menu options.
Print

The Print button can be used to print the selected report.
Double-clicking a report can also be used to print the
report.

Modify

The Modify button can be used to edit the selected report.
After clicking the Modify button, either the Report Wizard
or Report Writer Editor will be opened depending on
which editor is listed in the Table of Contents.

Cancel

The Cancel button can be used to close the Report Writer
window.

Report Writer Toolbar
The following toolbar buttons are available in the Report Writer window:
Create Report

Use this button to create a new report. The Report Name
window (Figure 7) will be displayed followed by the Report
Writer Editor (page 17).

Create Client Summary Report

Use this button to create a new Client Summary Report
(page 42). The Report Name window will be displayed
followed by the Report Writer Editor.
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Report Wizard

Use this button to create a report using the Report Wizard
(page 12). The Report Name window will be displayed
followed by the Report Wizard.

Print Report Definition

Use this button to print a report definition for the selected
report.

Rebuild Table of Contents

Use this button to rebuild the Table of Contents file (page
44).

Report Writer Right-Click Menu Options
The following menu options are available when right-clicking in the Report Writer window.
Print

The Print menu option can be used to print the selected
report. Double-clicking a report can also be used to print
the report.

Print Definition

The Print Definition menu option can be used to print a
report definition for the selected report.

Print Client Summary Report

The Print Client Summary Report menu option can be
used to print a Client Summary Report "on the fly" for a
specified range of clients.

Modify

The Modify menu option can be used to edit the selected
report. After selecting the Modify menu option, either the
Report Wizard or Report Writer Editor will be opened
depending on which editor is listed in the Table of
Contents.

Create Report

The Create Report menu option can be used to create a
new report. The Report Name window will be displayed
followed by the Report Writer Editor.

Create Client Summary Report

The Create Client Summary Report menu option can be
used to create a new Client Summary report. The Report
Name window will be displayed followed by the Report
Writer Editor.

Report Wizard

The Report Wizard menu option can be used to create a
report using the Report Wizard. The Report Name window
will be displayed followed by the Report Wizard.
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Rename

The Rename menu option opens the Report Name
window, allowing you to give the selected report
definition a different name.

Copy

The Copy menu option opens the Report Name window,
allowing you to copy the selected report definition to a
new name.

Delete

The Delete menu option allows you to delete the selected
report definition. You will be asked to confirm that you
want to delete the report definition.

Filter

The Filter menu option lets you filter which reports are
shown in the Table of Contents.

Rebuild

The Rebuild menu option can be used to rebuild the Table
of Contents file.

Report Wizard
PracticeMaster's Report Writer includes a Report Wizard that can be used to create basic reports. The
Report Wizard guides you through the report creation process step by step. Reports that are created
using the Report Wizard will be displayed with "Wizard" under the Editor column of the Table of
Contents in the Report Writer window.
The Report Wizard can be accessed by:
l

Clicking the

button in the Report Writer window to add a new report.

l

Selecting a "Wizard" report in the Report Writer window and clicking the Modify button.

l

Right-clicking a "Wizard" report in the Report Writer window and selecting the Modify menu
option.

The Report Wizard is extremely easy to use. It consists of three panels: the Main panel, the Fields
panel, and the Finish panel.
The Back and Next buttons can be used to move from panel to panel.
The Finish button saves the report definition and closes the Report Wizard.
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Main Panel
The Main panel is the first panel of the Report Wizard.

Figure 8, Report Writer Wizard - Main panel

From this panel, you can specify the following information:
Title

Maximum of 35 characters. The Title is used in the Table of
Contents and is also used as the default report heading.

Primary File

By default, the Primary File is the Client File. The primary
file contains the "core" of the information required for the
report. If you want your report to use a different file, click
the Change File button. All records in the primary file can
be selected. For example, if you want fees and client
information for every client who has fees, select the Fee
file instead of the Client file.

The Change File button will open a Select File window that can be used to select a different primary
file.
The Next button will advance to the next panel.
The Cancel button will discard any changes made and close the Report Wizard. If you are adding a
new report, the Cancel button will abort the entire report definition. If you are editing an existing
report, the Cancel button will cancel all changes, close the Report Wizard and revert to the previous
report definition.
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Fields Panel
The Fields panel is the second panel of the Report Wizard. From this panel, you can select which
fields you want included on the report.

Figure 9, Report Writer Wizard - Fields panel

Two lists of fields are shown in this panel. On the left, the Available Fields column includes a list of
all fields in the primary file. On the right, the Report Fields column includes a list of all fields that
have been selected for the report.
Adding a Field

To add a field to the report, select the field and click Add->. Or you can double-click a field in the Available Fields
list to add it to the Report Fields list.

Removing a Field

To remove a field from the report, select the field in the
Report Fields list and click <--Remove. Or you can
double-click a field in the Report Fields list to remove it
from the list.

The Move Up and Move Down buttons can be used to reposition a selected field in the Report
Fields list. The order of the fields in the Report Fields list indicates the order of the columns on the
report.
The More Fields button opens the Select Fields window, allowing you to select a lookup field or a
system defined field.
The Report Fields list includes the following information:
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Accumulate
The Accumulate column is available for numeric field types. Clicking in this column for a numeric
field will display the various options available.
Blank

Leave this field blank if you do not want a total
accumulated for the specified item.

Total

Select Total if you want a total accumulated for a specified
item.

Average

Select Average if you want an average calculated for a
specified item.

Sort
The Sort column determines which field will be used for sorting. Clicking in this column for a field
will display the various options available. A Primary Sort and Secondary Sort can be selected. Only
one Primary and one Secondary Sort can be selected using the Report Wizard. If you have selected a
field for the Primary Sort and want to change it, you must first change the field with a Primary Sort to
blank.
Blank

Leave this field blank if you do not want the field to be
used for sorting.

Primary

Select Primary if you want the report to use the field for
the Primary Sort.

Secondary

Select Secondary if you want the report to use the field for
the Secondary Sort.

Note: Additional sorts can be defined using the Report Writer Editor.
The Back button will move back to the previous panel.
The Next button will advance to the next panel.
The Cancel button will discard any changes made and close the Report Wizard. If you are adding a
new report, the Cancel button will abort the entire report definition. If you are editing an existing
report, the Cancel button will cancel all changes, close the Report Wizard, and revert to the previous
report definition.
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Finish Panel
The Finish panel is the third and last panel of the Report Wizard. From this panel, you can save the
report definition and exit the Report Wizard, cancel changes, move back to the previous panel, or
access the Report Writer Editor.

Figure 10, Report Writer Wizard - Finish panel

Editor

The Editor button will open the Report Writer Editor. The
Editor in the Table of Contents will be changed from
"Wizard" to "Editor". While in the Editor, you can modify
field widths, alignment, spacing, and more. After saving
your changes in the Editor, if you want the report to be
changed back to a "Wizard" report, simply click the
button to launch the Report Wizard, click Next Twice and
click Finish.

The Back button will move back to the previous panel.
The Finish button will save the report definition and close the Report Wizard.
The Cancel button will discard any changes made and close the Report Wizard. If you are adding a
new report, the Cancel button will abort the entire report definition. If you are editing an existing
report, the Cancel button will cancel all changes, close the Report Wizard, and revert to the previous
report definition.
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Report Writer Editor
The Report Writer Editor is used to create and modify report definitions in PracticeMaster’s Report
Writer. Reports that are created or last modified using the Report Writer Editor will be displayed with
“Editor” under the Editor column of the Table of Contents in the Report Writer window.
The Report Writer Editor consists of a unique toolbar, a file tree in the left pane that can be toggled
off or on, and multiple tabs in the right pane that are used to define the various report components.

Figure 11, Report Writer Editor window

The Report Writer Editor can be accessed by:
l

Clicking the

or

buttons in the Report Writer window to add a new report.

l

Selecting an "Editor" report in the Report Writer window and clicking the Modify button.

l

Right-clicking an "Editor" report in the Report Writer window and selecting the Modify menu
option.

l

Clicking the Editor button on the Finish panel of the Report Wizard.

The following tabs are available in the right pane of the Report Writer window and are used to define
the various report components:
l

Main

l

User Defined Fields

l

Filter

l

Image Layout
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Before we look at the contents of the various tabs in the right pane, let's look at the file tree and
toolbar buttons.

Report Writer Editor File Tree
The File Tree pane is shown on the left side of the Report Writer Editor window. The
button can
be used to toggle the File Tree pane so it is shown or hidden. The File Tree pane is used to specify the
files that will be used to retrieve the information for the report. This pane consists of a file tree
structure that shows all files included in the report. Each group of files is represented by a branch
with a

icon. Clicking the

icon left of a branch expands the branch to display the various files

in that folder. Likewise, clicking the

icon left of a branch will collapse its contents.

This tree structure allows easy access to all File Tree activities by right-clicking the appropriate
branch on the tree to display the associated menu. Double-clicking a file can be used as a shortcut
to display the portion of the detail image layout for that file.
Detail Image Note: In the Report Writer, portions of the layout of a report are referred to as Detail
Images. Each report has one or more Detail Images. You can also define Detail Images for a User
Defined Page Heading and Sort Headings. Detail Images are defined on the Image Layout tab of
the Report Writer Editor.
The groups of files included in the tree depend on whether you are working with a Simple Report or
a Client AOP Report. Each file in the report has an associated detail image that can be edited using
the Image Layout tab.

Simple Report
When working with a Simple Report or Wizard Report, a single group of files will be shown in the File
Tree.
Report Files

"Report Files" is the only group of files shown when
working with a simple report. The first file selected for a
Simple Report is referred to as the primary file. The primary
file contains the "core" of the information required for the
report.
Additional files can be selected with the following
restrictions:
l

If the Client file is selected as the primary file, no
other file can be selected.
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l

If you select a lookup file such as the Contact file,
Timekeeper file, Transaction Code file, Category
file, etc., only that file can be selected.

l

Files from different Areas of Practice cannot be
used in the same report. Use a Client AOP Report if
you want to include information from different
Areas of Practice.

l

A Simple Report has only one detail image.

Client AOP Report
When working with a Client AOP Report, several groups of files may be shown in the File Tree. Each
file is also referred to as a section. Each section consists of a detail image for the specified file.
System Files

Includes only the Client file.

Leading System Files

Includes information from the various client related files.
The default Client Summary Report does not include any
leading system files.

Area of Practice Files

Includes information from the Area of Practice files
associated with the client.

Trailing System Files

Includes information from the various client related files.
The default Client Summary Report includes sections for
the Journal file, Calendar file, Document Management file,
Fee file, and Cost file.

Note: The order of the files within the groups indicates the order they will be printed on the report.
However, the primary print order is always: System Files, Leading System Files, Area of Practice
Files, Trailing System Files.

Report Writer Editor Toolbar Buttons
The following toolbar buttons are available in the Report Writer Editor. Not all buttons are available
at all times.
Save

This button saves the changes to the report definition.
Whenever a report definition is saved, PracticeMaster
checks the report definition for errors. If errors are found,
you will be asked if you want to view an error list. All errors
must be resolved before a report definition can be saved.

- 19 -

PracticeMaster Report Writer Guide

Print

This button can be used to print the report.

Print Definition

This button can be used to print a report definition for the
report.

Add AOP

This button can be used to add an Area of Practice to a
Client AOP Report.

Add Section

This button can be used to add a section to a Client AOP
Report definition.

Add File

This button can be used to add a file to a Simple Report.

Add Field

This button can be used to display the Select Field
window, allowing you to add a field from a file, a system
field, or a user defined field. This button is also used to
add a new user defined field on the User Defined Fields
tab.

Add Sort Region

This button can be used to add an ascending or
descending sort region to a report definition.

Add Text

This button can be used to add a Text Item. A Text Item is a
user defined string of characters. Text Items are commonly
used to define column headings for reports in NonColumn mode. The new item is inserted in the position
following the selected item.

Delete

This button can be used to delete the selected item.

Cut

This button, or Ctrl+X, can be used to cut the contents of
the selected item to the Windows Clipboard.

Copy

This button, or Ctrl+C, can be used to copy the contents of
the selected item to the Windows Clipboard.

Paste

This button, or Ctrl+V, inserts the item from the Windows
Clipboard at the pointer position in the active window.

Move Item Up

This button, or Shift+Up-Arrow, can be used to reposition
the selected item by moving it up one position.
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Move Item Down

This button, or Shift+Down-Arrow, can be used to
reposition the selected item by moving it down one
position.

Move Left

This button can be used to move the selected item left one
item.

Move Right

This button can be used to move the selected item right
one item.

Insert Space

This button can be used to insert a blank space before the
selected item.

Remove Space

This button can be used to delete a blank space before the
selected item.

Non-Column Mode

This button can be used to change a report to NonColumn Mode.

Column mode

This button can be used to change a report to Column
Mode.

Hide/Show Tree

This button acts as a toggle switch to hide or display the
File Tree.

Launch Wizard

This button can be used to launch the Report Wizard for
the selected report.

Help

This button, or F1, displays Help for the current window.
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Main Tab
The Main tab of the report definition is always shown first and is used to define the following
information. The Report Name and Structure as defined via the Report Name window are shown
for reference purposes and cannot be edited.

Figure 12, Report Writer Editor - Main tab

Title

Maximum of 35 characters. The Title is used in the Table of
Contents and is also used as the default report heading if
the Standard Page Heading is selected.
Note: If you want to use a report title greater than 35
characters, you must define a custom page heading. To
do so, change the Page Heading option to User
Defined. Then use the Image Layout tab to define the
user defined page heading.

Line Spacing

The Line Spacing field determines the amount of space
between all lines on the report. A minimum of 0.000 inches
up to 0.999 inches can be specified. This field gives you
greater control over the line spacing above and beyond
specifying double spacing.
The default is 0.000, which indicates standard line spacing.
When 0.000 is specified, the normal line spacing
associated with the specified font is used.
When a Line Spacing greater than 0.000 is specified, this
amount determines the amount of space from the bottom
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of one line to the bottom of the next line. If the amount
specified is too small, the lines on the report will overlap.
This setting applies to all printed lines on the report.
Note: You can select the Double Space check box if you
simply want to double space the body of the report.
Page Heading

The Page Heading determines the format of the heading
that will print at the top of each page of the report. The
default Page Heading is Standard.
None - None indicates no page heading will be used.
Standard - The standard page heading consists of two
lines. The first line includes the system date, the Title and
the page number. The second line consists of the firm’s
name defined in the Firm Information window of the
System Configuration program. The following is an
example of a standard page heading.

User Defined - User defined page headings are defined on
the Image Layout tab.
Tip: When defining a non-column report that has
column headings and you want the column headings to
appear at the top of each page, define a User Defined
page heading that includes the column headings.
Note: If User Defined is selected for the Page Heading
and a User Defined Page Heading is not defined, no
page heading will be used.
Double Space Report

Select this check box if you want the report double
spaced. Double spacing applies to the entire report except
for standard page headings and column headings.
Clear this check box if you want the report single spaced.
Note: You can use the Line Spacing field to increase the
amount of space between all lines on the report.
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Prompt for Current Date

Select this check box if you want the user to be prompted
for the current date when the report is run. This date will
be used in lieu of the system date for any date functions.
Clear this check box if you want the system date to be
used for the current date.

Output Type

The Output Type determines the format of the finished
report. The default Output Type is Detail.
Detail - The Detail type includes detailed records and all
specified totals, headings, averages, etc.
Summary - The Summary type excludes individual
detailed records but includes totals, headings, averages,
etc.
Export As - The Export As type is commonly used when
saving the report to a file for use with other software
programs. When this option is selected, you have the
following options:
Note: When exporting fields, the entire field is exported
regardless of the Field Width specified.
Comma Quote Delimited
The Comma Quote Delimited format is a standard comma
delimited ASCII text file. The following field types are
exported as quoted strings: Alpha, Contact, E-mail,
Enhanced Virtual, File, Lookup, Memo, Phone, User,
Virtual, and Web Page.
Boolean fields are exported with whatever is specified in
the True Text or False Text fields of the properties for the
field.
Client ID fields are exported as 12-character fields, right
justified with leading spaces for numeric Key Type, or left
justified for Alpha or Mixed Key Type.
Date fields are exported using either the “mm/dd/yyyy” or
“mm/dd/yy” format depending on how the Date Format is
configured for the properties of the field.
Time fields are exported using the “hh:mm” or “hh:mm
AM” format depending on how the Time Format is
configured for the properties of the field.
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WordPerfect Mail Merge
The WordPerfect Mail Merge format is used to create a
WordPerfect® secondary merge file. Each record is
separated by a Merge E (^E followed by a hard page). Each
field is separated by a Merge R (^R followed by a hard
return).
MS Word Mail Merge
The MS Word Mail Merge format is used to create a
Microsoft® Word Mail Merge file. This file format is similar
to the comma quote delimited file with the following
exceptions: 1) a header record is added to the beginning
of the file that lists the field names; and 2) all double
quotation mark characters are replaced with two double
quotation mark characters.
Primary Index

Specifying a different index can often help a report
process more quickly. By default, reports use the key index
as the default index. This may or may not be the most
efficient index for the report you are creating. If your
report takes a long time to run, consider trying a different
index. You may want to add a new index that matches the
type of sorting your report requires.
If the primary index handles the sorting desired, there is
less need to define a Sort Region for the report because
the records are automatically accessed in the desired
order. However, sort regions may be required for
headings, totals, or other formatting purposes.
For example, a Client List uses the Client File whose default
index is the Client ID index. However, if the Client List you
are designing is in alphabetical order, it will be more
efficient to select an index that uses an alpha sort.
As another example, if you are defining a calendar report
that shows calendar entries for a specific user, you would
want to select a Primary Index that sorts the calendar
entries by user.
Indexes are defined in File Maintenance on the Index tab
of the File Definition program.
This field is not available until a file has been added to the
report.
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Note: Default beginning and ending values will be
included on the System tab of the Select Field window
for the first sort order of the specified index. When the
report is run, the user will automatically be prompted for
these beginning and ending values. For example, if the
first sort order of the Primary Index is user, then the user
will automatically be asked for the beginning and ending
User ID.
Note: Changing the Primary Index can cause unexpected
results if the BEG_RANGE and END_RANGE system fields
are used.

User Defined Fields Tab
The User Defined Fields tab is used to define custom fields. User defined fields can be used in the
Image Layout, user defined page headings, and sort regions. They can also be used within another
user defined field. There is no limit to the number of user defined fields that can be created.
The value of a user defined field can be set up in one of two ways:
l

Entered by the user when the report is run

l

Determined by the Expression entered in the Default Value of the user defined field

Figure 13, Report Writer Editor - User Defined Fields tab
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The User Defined Fields tab is a list of user defined fields. Each row consists of a single user defined
field. You can use the PgUp, PgDn, Up-Arrow, Down-Arrow, Left-Arrow, Right-Arrow, Home, and
End keys to scroll through existing user defined fields. Scroll bars can also be used to scroll through
the list of user defined fields. You can change the sort order of fields by clicking a column heading.
Double-clicking a user defined field in the list will open the User Defined Field Properties window for
the field. The following figure is an example of a User Defined Properties window.

Figure 14, User Defined Field Properties window

Field Name (or "Name" in the list)

The user defined field name. Maximum 20 characters. The
Field Name is used to identify the user defined field within
the report definition. Characters that can be used include
A-Z, 0-9, and the underscore character. The first character
must be a letter.

Field Type (or "Type" in the list)

The field type of the user defined field. The Field Type
determines the type of information that can be entered in
the user defined field. The Field Type also determines
which functions and operators can be used in the Default
Value as well as for the Properties window when a user
defined field is added to the Detail Image Layout. The
available field types are Alpha, Contact, Short Integer,
Integer, Number, Money, Boolean, Date, Time, Client ID,
User, and Character.

Default Width

Maximum of 128 characters. The Default Width only
applies when the Field Type is Alpha. The Default Width
determines the following:
l

When the Runtime Prompt check box for the user
defined field is checked, the Default Width
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determines the maximum number of characters
that can be entered by the user when the report is
run.
l

When the user defined field is used in the Image
Layout, the Default Width determines the default
Field Width.

Note: The Default Width is ignored when using an
Output Type of Export As.
Runtime Prompt (or “P” in the list)

This check box determines whether the user will be
prompted to enter a value for the user defined variable at
runtime.
Select this check box if you want the user to be prompted
to enter the value of the user defined field when the report
is run. The label used for the prompt can be specified in
the Prompt field. If desired, a default value can be
specified in the Default Value field. When the user prints
the report, all user defined variables whose Runtime
Prompt check box is selected will be displayed in a
Runtime window, allowing the user to specify a value
before the report is processed.
Clear this check box if you do not want the user to be
prompted to enter information. When this check box is
cleared, the Prompt field becomes unavailable.
Note: The “P” column on the list of the User Defined
Fields tab includes an “S” (string) or an “E” (expression)
or is blank. When it is blank, the Runtime Prompt check
box is not selected. When it is “S,” the Runtime Prompt
check box is selected and a string is entered in the
Default Value field. When it is “E,” the Runtime Prompt
check box is selected, the Regular Expression check box
is selected, and an expression is entered in the Default
Value field.

Prompt

Maximum of 50 characters. The Prompt field is available
only when the Runtime Prompt check box is selected.
This field represents the label of the runtime prompt that
will be seen by the user at runtime.
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Default Value

The information stored in this field represents the initial
value of the field. Whether this value can be overwritten
by the user depends on how the Runtime Prompt check
box is set.
If the Runtime Prompt check box is selected and the
Regular Expression check box is not selected, then the
value in this field will be used as a default value for the
prompt at runtime, allowing the user to accept or
overwrite this default value. In this situation, an “S” for
string will be shown in the P (Prompt) column on the User
Defined Fields tab.
If the Runtime Prompt check box is selected and the
Regular Expression check box is selected, then the
Default Value represents an expression that should be
evaluated and used as the default value for the prompt at
runtime, allowing the user to accept or overwrite this
value. In this situation, an “E” for expression will be shown
in the P (Prompt) column on the User Defined Fields tab.
If the Runtime Prompt check box is not selected, then the
default value simply represents the initial value of this
field. The contents will be evaluated as an expression. The
user will not be asked for a value for this field.
Expression
The contents of the Default Value may include an
expression if the Regular Expression check box is selected.
An expression contains a formula that determines the
value of the field. The formula entered can include fields,
operators and functions as well as text.
l

The FUNCTION button can be used to open the
Available Functions window, allowing you to select
the desired function.

l

The OPERATOR button can be used to open the
Available Operators window, allowing you to select
the desired operator.

l

The FIELD button can be used to open the Select
Field window, allowing you to select the desired
field from a file, system field or user defined field.
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Note: The “Formula” column on the list of the User
Defined Fields tab represents the Default Value or
Expression for the user defined field.
Regular Expression

The Regular Expression check box determines whether
the contents of the Default Value field will be evaluated as
an expression.
If the Runtime Prompt check box is cleared, this check
box is automatically selected, thus causing the Default
Value to be evaluated as an expression.
If the Runtime Prompt check box is selected, you can use
an expression to calculate the default value or you can
simply enter the default value.
Select the Regular Expression check box if you want the
contents of the Default Value field evaluated as an
expression.
Clear the Regular Expression check box if you simply want
to set an initializing value without having any calculations
performed.
When the Regular Expressioncheck box is selected, the
FUNCTION, OPERATOR and FIELD buttons are available
to help build an expression.The FIELD button can be used
to open the Select Field window, allowing you to select
the desired field from a file, system field or user defined
field.

The OK button can be used to save the changes, close the Properties window and update the User
Defined Fields tab. When saving a user defined field, you may receive a “Type Mismatch” error. This
error must be resolved before the user defined field can be saved. This error is usually the result of
having a mismatched Field Type and Default Value. For example, if a function is performed on an
alpha field but returns a numeric value, then the Field Type must be configured as Numeric. If the
field is configured as alpha, it will generate a “Type Mismatch” error.
The Cancel button can be used to close the Properties window without updating the User Defined
Fields tab.
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Filter Tab
The Filter tab lets you define a query expression to specify selection criteria that are used to
determine whether or not a record should be included on the report. Query expressions are Boolean
expressions which are evaluated as being true or false.

Figure 15, Report Writer Editor - Filter tab

And/Or

The And/Or column is used to select And or Or for the
queries. This field is not available for the first query.
Select And if you want the previous query and the current
query to be true in order for the record to be selected.
Select Or if you want the previous query or the current
query to be true in order for the record to be selected.
Note: Multiple queries are tested in the order they are
presented. You can use the Move Up and Move Down
buttons to change the order of queries as desired.

Field Name

The Field Name column is used to specify the desired field
from the file. The drop-down button can be used to open
the Select Field window.
Note: A Field Name must be selected before being able
to specify any other fields in the row.

Test Condition

You can select one condition per query. The following test
conditions are available:
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l
l
l
l
l
l
l
l
l
l

Test Value

Equal To
Not Equal To
Greater Than
Greater Than or Equal To
Less Than
Less Than or Equal To
Contains (Alpha fields only)
Does Not Contain (Alpha fields only)
is TRUE (Boolean fields only)
is FALSE (Boolean fields only)

The information that can be entered in the Test Value field
depends on whether the Field Name specified is alpha,
numeric, date, time or Boolean. Enter the value you want
used for comparison purposes.
l

Alpha - Alpha strings are allowed when the field is
alpha. Maximum of 128 characters.

l

Numeric - Maximum of 14 characters (including
decimal point and minus sign, if used).

l

Date - An "mm/dd/yyyy" format is used for date
fields.

l

Time - An" hh:mm p.m." format is used for time
fields.

l

Boolean - A value of "1" is used for true and a
value of "0" is used for false.

The New Row button can be used to add a query to the query expression. After selecting the Field
Name, use the tab key or the mouse to place focus in the different columns to select the other fields
in the row.
The New Advanced Row button opens the Advanced Expression Editor window. Once an Advanced
Expression has been saved, you can click anywhere in the row to edit the expression.
The Delete button can be used to delete the selected query. Any subsequent queries will be moved
up one position.
The Move Up button can be used to move the selected query up one row.
The Move Down button can be used to move the selected query down one row.
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Note: Additional information regarding functions, operators, expressions, and the Select Field
window can be found in Help.

Advanced Expression Editor
The Advanced Expression Editor window is opened by clicking the New Advanced Row button. The
Advanced Expression Editor window lets you define an expression for filtering purposes. Query
expressions are Boolean expressions which are evaluated as being true or false.

Figure 16, Advanced Expression Editor window

Expression

The Expression field provides the option to enter a custom
expression. You can type in an expression or use the
Value, Field, Function, and Operator buttons to build an
expression. There is no limit to the length of the
expression.

The Value button can be used to open the Value window, allowing you to enter a value to insert into
the expression.
The Field button can be used to open the Select Field window, allowing you to select the desired
field from the file.
The Function button can be used to open the Available Functions window, allowing you to select
the desired function.
The Operator button can be used to open the Available Operators window, allowing you to select
the desired operator.
The Full Expression field displays the full expression for the filter thus far. This field is updated
immediately upon any change to the Expression field and displays a representation of all previous
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queries AND the full expression prior to saving. The Full Expression field is not editable; however,
you can copy any portion of the field to the clipboard.

Image Layout Tab
The Image Layout tab includes an Image Layout Editor that lets you define each item that will be
used on the report and where it will be positioned. The Image Layout Editor uses a graphical user
interface complete with drag-and-drop capabilities. This program is used to define the Detail Image,
Sort Regions, and user defined page headings.

Figure 17, Report Writer Editor - Image Layout tab

The Image Layout Editor shows an image of the information as it will be portrayed on the report. This
image is updated each time an item is added, changed, moved, or deleted. The background of the
Image Layout Editor shows dots in a grid-like pattern, thereby assisting with alignment of the various
items on a page. The toolbar buttons and right-click menus can be used to access the various
activities in the Image Layout Editor.
The various items added using the Image Layout Editor are categorized by region. Each region has a
heading bar. When adding or editing an item in a region, a properties window will be displayed.
The arrow keys can be used to select an item. When selected, items are shown in yellow. The arrow
buttons on the toolbar can be used to reposition a selected item. Double-clicking an item or
pressing the Enter key when an item is selected displays a Properties window, allowing you to edit
the associated item. The Home key will display the top of the detail image.
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The fields in a Properties window vary depending on the field type and whether the report is in
column mode or non-column mode. Complete details regarding the various fields in the Properties
window can be found in the Help provided with PracticeMaster.

Figure 18, Field Properties window

There is no limit to the number of items that can be added to the Detail Image.

Legend
The following contains information regarding symbols that may be seen in the Image Layout Editor.
Column Headers are shown if Column Mode is selected. The various field types show different
symbols:
l

Alpha fields (including Alpha, E-mail, Enhanced Virtual, File, Memo, Phone, Lookup, Virtual,
and Web Page fields) are portrayed by an uppercase "X" (or uppercase "W" representing
wrapping). A single character alpha field is portrayed by an uppercase "C" (i.e., a Character
field).

l

Contact fields are portrayed by an uppercase "R" (or uppercase "W" representing wrapping).

l

Numeric fields (including Number and Money fields) are portrayed by the "#" character.
Commas and dollar signs may be displayed if selected in the Properties window. Minus signs,
parentheses, or "cr" characters may be included in numeric fields if negative numbers are
allowed.

l

Date fields are portrayed by "mm/dd/yy" or "mm/dd/yyyy" depending on the format
specified.

l

Time fields are portrayed by "hh:mm" or "hh:mm AM" depending on the format specified.
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l

Boolean fields are represented by the largest possible value specified in the True Text or False
Text fields.

l

Client ID fields are represented by "A" (alpha), "N" (numeric), or "M" (mixed).

l

User ID fields are represented by "U".

A vertical red line that spans the entire height of the report indicates a width of 256 characters.
A vertical red line that is only one row high between two items indicates that the two items are
touching.

Status Bar
The status bar shows information regarding a selected item or region.
Region

When a heading bar of a region is selected, the status bar
indicates the width of the region in columns, the height of
the region in rows, and the number of items in the region.

Item

When an item is selected, the status bar indicates the
name of the item, the item number within the region, and
the starting column position of the item.

Image Layout Editor Right-Click Menu Options
The following represents a list of right-click menu options available in the Image Layout Editor of the
Report Writer Editor.
Add Field

The Add Field menu option or the
button can be used
to display the Select Field window, allowing you to add a
field from a file, a system field, or a user defined field.

Add Sort Region

The Add Sort Region menu option or the
button can
be used to add an ascending or descending sort region to
a report definition.

Add Text

The Add Text menu option or the
button can be used
to add a text item. A Text Item is a user defined string of
characters. Text Items are commonly used to define
column headings for reports in Non-Column Mode. The
new item is inserted in the position following the selected
item.
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Change Field Name

The Change Field Name menu option can be used to
change the field name. Once a field has been added, you
can edit the Properties for the field; however, you cannot
change the name via the Properties. This menu option
eliminates the need to delete an item and re-add it with
the new field name.

Cut

The Cut menu option or the
button or Ctrl+X can be
used to cut the contents of the selected item to the
Windows Clipboard.

Copy

The Copy menu option or the
button or Ctrl+C can be
used to copy the contents of the selected item to the
Windows Clipboard.

Paste

The Paste menu option or the
button or Ctrl+V inserts
the item from the Windows Clipboard at the pointer
position in the active window.

Delete

The Delete menu option or the
delete the selected item.

Move Up

The Move Up menu option or the
button or Shift+UpArrow can be used to reposition the selected item by
moving it up one position.

Move Down

The Move Down menu option or the
button or
Shift+Down-Arrow can be used to reposition the selected
item by moving it down one position.

Move Left

The Move Left menu option or the
button can be used
to move the selected item left one item.

Move Right

The Move Right menu option or the
button can be
used to move the selected item right one item.

Insert Space

The Insert Space menu option or the
button can be
used to insert a blank space before the selected item.

Delete Space

The Delete Space menu option or the
button can be
used to delete a blank space before the selected item.
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Join Lines

The Join Lines menu option is used to delete a line break
before the selected item. This option is available in NonColumn Mode only.

Break Line

The Break Line menu option is used to insert a line break
before the selected item. This option is available in NonColumn Mode only. You must add an item for the
following line before you can add a break. To create a
blank line as the last item in an image, add a 1-character
text item with no text and insert a line break before the
blank text item.

Properties

The Properties menu option will display a Properties
window for the selected item, allowing you to edit the
item.

User Defined Page Headings
The type of Page Heading used in a report is defined in the Page Heading field on the Main tab of
the Report Writer Editor. Page Heading options consist of Standard, User Defined, or None. When a
User Defined Page Heading is specified, it is created via the Image Layout Editor program.
▶ To define a User Defined Page Heading
1. Select the desired report in the Report Writer window.
2. Click the Modify button.
3. In the Page Heading field of the Main tab, click the drop-down button and select User
Defined.
4. Click the Image Layout tab.
5. Select the Page Heading heading bar.
6. Use the
button to add the desired fields to the Page Heading region. Typical items in a
page heading might consist of any of the following System Fields: FIRMNAME$, DATE, TIME,
PAGENO, etc. Use the
button to add any text labels to the Page Heading region. Typical
text in a page heading might consist of a label for the page number such as “Page No.: ” and
a label for the Date.
7. Once all items have been entered, click the

button to save the report definition.

Tip: To create a blank line as the last item in an image, add a 1-character text item that has no text
and insert a line break before or after the blank text item.
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Sort Regions
Sort regions are used to define sort levels, page breaks and totaling. For each sort region defined, a
heading image can be defined as well as subtotal text and the format of the subtotal. A page break
or a certain number of lines can be specified following a break. Sort regions can have heading
images, subtotal text, or both. There is no limit to the number of sort regions that can be defined for
each report. The order that the sort regions are listed in reflects the order of the sorting performed.

Figure 19, Sort Properties window

Note: Subtotals or averages will print for any numeric items that have been set up to do so in their
Properties. This is done by specifying the appropriate value for the Accumulate field. When
defining the Sort Region, you can specify the text that will print to the left of the results and the
format of the results (i.e., whether underscores or double underscores or blank lines are placed
below or above the results).
After selecting to add a sort, a Sort Properties window will be displayed. The following fields are
available in the Sort Properties windows for each sort region defined:
Field Name

The Field Name is automatically assigned when you add a
sort region. When adding a sort region, the Select Field
window will be displayed, allowing you to specify the field
you want the sort based on. The field specified will be
used as the Field Name.
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The Field Name can be changed. The drop-down button
can be used to display the Select Field window to select a
different field on which to sort.
Sort Order

The Sort Order determines whether sorting is in
Ascending or Descending order. The default Sort Order is
Ascending.
Select Ascending if you want the specified field sorted in
ascending order (A-Z).
Select Descending if you want the specified field sorted in
descending order (Z-A).
Note: When defining a Global Sort Region, it makes no
difference whether the Sort Order is Ascending or
Descending.

Header Position

Use this option to specify whether you want the column
headings repeated for each break. The default is No
Header.
Select No Header if you do not want the column headings
to print following each break.
Select Before if you want the column headings for the
detail image to print before each break.
Select After if you want the column headings for the
detail image to print following each break. Column
headings will also print at the top of each page of the
report.
Note: The Header Position option applies only when the
report is in Column Mode.

Subtotal Text

Maximum of 128 characters. Enter the text to print on the
subtotal line prior to the results. This line prints on the
same line that the results print on (provided the width of
the text does not exceed the column width).

Subtotal Lines 1-4

Up to four lines can be used to format the results portion
of the subtotal. The Subtotal Lines are used for formatting
the subtotal.
Select Nothing if you do not want anything to print on the
specified line of the subtotal format.
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Select Blank if you want a blank line to print on the
specified line of the subtotal format.
Select Underline if you want a row of dash characters (i.e.,
“-”) to print on the specified line of the subtotal format.
Select Double if you want a row of equal sign characters
(i.e., “=”) to print on the specified line of the subtotal
format.
Select Results if you want the results to print on the
specified line of the subtotal format.
Lines To Skip After Break

Specify the number of blank lines or a new page to be
printed following each break for the specified sort.
Select 0 if you do not want any blank lines to print after a
break.
Select 1, 2, 3, or 4 to specify the number of blank lines you
want printed following a break.
Note: Blank lines following a break are only printed if a
subtotal is printed.
Select Page Break if you want a new page following a
break.

The OK button will save the sort region.
The Cancel button will close the window without saving any changes.

GLOBAL System Field
The Global System Field is used when defining the Global Sort Region in the Image Layout. The
Global Sort Region is not used to select a sort order. Sorting on the Global system value provides a
way to add grand totals and/or a sort heading that applies to the entire report. The Global Sort
Region can also be used for accumulating and printing final totals or averages. The Global Sort
Region is used to define the text on the subtotal line, as well as the type of underscore and number
of blank lines before and after the total.
Information included in an image that will only print on the first page of the report typically consists
of the parameters specified by the user when running the report. This additional information is
printed below the page heading. The information provided in a Global Sort Region could be
included in a user defined page heading; however, it would then print on every page of the report as
opposed to just the first page.
If used, the Global Sort Region should be the first Sort Region shown in the Image Layout.
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Tip: If you want column headings to appear only at the beginning of the first page, define the
column headings in the global sort image instead of the detail image.

Client Summary Report
The Client Summary Report is a summary of all information that has been entered for a specific
client. It consists of several sections including general client information, Area of Practice specific
information, journal information (timer, phone, research, note, e-mail records and Tabs3 billing
notes), calendar entries, document management entries, fee entries, and cost entries. Client
Summary Reports are created and generated using PracticeMaster’s Report Writer. Unique Client
Summary Reports can be created for each Area of Practice. Client Summary Reports can be
customized as desired.
Depending on how your Client Summary Report definitions are coded, it is possible to use the same
Client Summary Report for all clients. You can also run Client Summary Reports for multiple clients at
the same time.
PracticeMaster comes with two special Client AOP Reports that can be used as a basis for your own
Client Summary Reports:
SYSTMSUM.RW

This specially provided Client AOP Report definition
includes coding for all system file sections. Coding for
Area of Practice Files is not included.

CLNTSUM.RW

This specially provided Client AOP Report definition
includes sections for system files and Area of Practice
Files. Sections for Area of Practice Files will only show for
clients within that specific Area of Practice. For example, if
you run this report for a Tax client, information for the
system files and Tax Area of Practice Files will be included.

Creating a Client Summary Report
The following scenarios provide steps on creating, copying, and editing a Client Summary Report.

Creating a New Client Summary Report
Besides using the precoded Client AOP Reports provided with PracticeMaster, you can also generate
your own Client Summary Report “on the fly.” A Client Summary Report that is created on the fly can
be generated by:
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l

Right-clicking the Report Writer window and selecting Print Client Summary Report.

l

From the Reports Task Folder, select Client Summary Report.

You can use the
button in the Report Writer Editor to generate the same on-the-fly Client
Summary Report, save it and customize it as desired.
Tip: The easiest way to work with the Client Summary Report is to always use the CLNTSUM.RW
report for all clients. Customize the sections for the system files and existing Area of Practice
sections as required. If you add a new Area of Practice, add a new Area of Practice section to this
report and customize it as required.

Creating a New Client Summary Report Based on an
Existing Report
You can copy the existing CLNTSUM.RW report, and then further edit the report definition as
needed. This option keeps the original report available to run as necessary, or to copy again as a
base for other reports.
▶ To create a new Client Summary Report based on an existing Client AOP Report
1. From the Report Writer window, select the CLNTSUM.RW report.
2. Right-click the Report Writer window and select Copy.
3. Enter the new report name and click OK.
4. Select the new report.
5. Click Modify.
6. The Report Writer Editor will be opened, allowing you to edit the report as desired.

Adding a New Area of Practice to an Existing Client
AOP Report
If there is an existing Client Summary Report you want to run with the addition of specific AOP
fields, you do not need to create a new report. Instead, you can add an AOP to the existing report.
▶ To add an Area of Practice to an existing Client AOP Report
1. From the Reports menu, select Report Writer.
2. From the Report Writer window, select the desired Client Summary Report.
3. Click Modify.
4. The Report Writer Editor will be opened, allowing you to edit the report.
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5. In the File tree, right-click System Files and select Add Area of Practice. Your new Area of
Practice section will be added to the bottom of the File tree.
6. Use Shift+Up-Arrow to position the Area of Practice to the desired position.
7. Right-click the Area of Practice you just added and select Fill Area of Practice. A section for
each file in the specified Area of Practice will be added.
8. You can edit any section as desired. To edit a section, select the file and click the Image
Layout tab. Double-click any item to display its properties.
9. After you have completed editing, click

to save the report definition.

Rebuild Table of Contents
The
button or the Rebuild right-click menu option can be used to rebuild the table of contents.
Running this program deletes the current table of contents file and rebuilds a new one based on all
existing report definitions (i.e., files in the \CMREPORT directory that have a file extension of “.RW”).
After starting the rebuilding process, you will be asked to confirm that you want to rebuild the Table
of Contents. Once confirmed, the rebuild process will begin and a progress indicator will be shown.
The rebuild process takes a matter of seconds to complete and cannot be aborted once started.
Running this program does not delete any data. It can be run multiple times without having any
adverse effect.

Why would I want to rebuild the Table of Contents?
Typically, you shouldn’t have to rebuild the Table of Contents. The most common reason for having
to rebuild is when you receive a report definition from a third party. For example, if your reseller or a
consultant creates a new report definition for you, the report definition file would have to be
transferred to the \CMREPORT directory. Once transferred, in order to access it via the Report Writer
window, it would have to be present in the Table of Contents file. Since this report wasn’t created by
the PracticeMaster system, it is not present in your Table of Contents file. Therefore, the Table of
Contents must be rebuilt in order to include the new report definition.
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Conclusion
Resources
The PracticeMaster Custom Report Writer provides the ability to create reports based on your firm's
needs. Additional features discussed in this guide can be found in the PracticeMaster Help. Simply
press F1 from anywhere within the software to open the Help information for that particular topic.

Sample Reports
Additional guides and resources for other software features are also available, including the
following:
l

PracticeMaster Sample Reports - Examples of each Report Writer Report included with the
software can be found in the PracticeMaster Sample Reports.

All guides and sample report packs are available on our Web site at:

Tabs3.com/support/docs.html

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.
The following Knowledge Base articles provide additional Report Writer information.
Article ID Article Title

Article Description

R11446

Working with PracticeMaster
Report Writer

Walks you through creating a report and provides information
on optimizing report writer reports, common situations, and
troubleshooting.

R10931

PracticeMaster Report Writer
Frequently Asked Questions

Provides answers to frequently asked questions about
PracticeMaster Report Writer.

R11493

All About Expressions

Provides an in-depth look at what expressions are, where they
are used, terminology, creating both basic and advanced
expressions, examples, and tips.

R11515

Filter Expression Examples

Provides more than 50 examples of how filters can be used.

R10750

PracticeMaster Report Writer,
Filter, and WorkFlow Functions

Provides a list of available functions in PracticeMaster, as well
as a link to a PDF that provides information on how each
function can be used in the software.

R10733

PracticeMaster Report Writer,
Filter, and WorkFlow
Expression Errors

Discusses how to interpret error information shown on the
Error Report and includes a list of common error messages.
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All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com

Training Videos
Training videos are multimedia resources that walk you through Tabs3 Billing and PracticeMaster
features. Over 100 training videos are available. The following video walks you through creating a
Client List via the Report Wizard that sorts clients by the city where the client is located. Additionally,
the options available to modify a Client Summary Report are also reviewed.
l

Custom Report Writer

All training videos are available on our Web site at:

Tabs3.com/videos
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